
Guide Calc
6.4

Chapitre 6
Imprimer, exporter, envoyer 
par courriel et signer





Droits d’auteur

Ce document est protégé par Copyright © 2019 par l’Équipe de Documentation de LibreOffice. Les
contributeurs sont nommés ci-dessous. Vous pouvez le distribuer et/ou le modifier sous les termes 
de la Licence Publique Générale GNU (https://www.gnu.org/licenses/gpl.html), version 3 ou ulté-
rieure, ou de la Licence Creative Commons Attribution
 (https://creativecommons.org/licenses/by/4.0/), version 4.0 ou ultérieure.

Toutes les marques déposées citées dans ce guide appartiennent à leurs légitimes propriétaires.

Contributeurs

Ce chapitre est une adaptation mise à jour du Guide Calc de LibreOffice 6.2.

Ont contribué à cette édition

Steve Fanning Leo Moons Kees Kriek

Ont contribué aux éditions précédentes

Barbara Duprey Jean Hollis Weber John A Smith
Peter Schofield Christian Chenal Martin Saffron
Kees Kriek

Traduction

De cette édition

Traducteurs Jean-Luc Vandemeulebroucke
Relecteurs Philippe Clément

Des éditions précédentes

Traducteurs Jean-Luc Vandemeulebroucke Christian Chenal
Relecteurs Philippe Clément François Bégasse

Retours

Veuillez adresser tout commentaire ou suggestion concernant ce document à la liste de diffusion 
de l’Équipe de Documentation : doc@fr.libreoffice.org

Remarque

tout ce que vous envoyez à la liste de diffusion, y compris votre adresse mail et toute autre 
information personnelle incluse dans le message, est archivé publiquement et ne peut pas 
être effacé.

Date de publication et version du logiciel

Publié en mai 2021. Basé sur LibreOffice 6.4.

La documentation française de LibreOffice est disponible à
https://wiki.documentfoundation.org/Documentation/Publications/fr

mailto:doc@fr.libreoffice.org
https://creativecommons.org/licenses/by/4.0/
https://www.gnu.org/licenses/gpl.html


Utiliser LibreOffice sur un Mac

Sur Mac, certaines touches et certains éléments de menu sont différents de ceux utilisés sous 
Windows ou Linux. Le tableau ci-dessous donne quelques substitutions courantes pour les instruc-
tions de ce chapitre. Pour une liste plus détaillée, voyez l’Aide de l’application.

Windows ou Linux Équivalent Mac Effet

Sélection du menu 
Outils > Options

LibreOffice > Préférences Accès aux options de configuration

Clic droit
Control+clic ou clic droit 
selon la configuration de l’ordinateur

Ouvre un menu contextuel

Ctrl (Control) ⌘ (Command) Utilisé avec d’autres touches

Ctrl+Q ⌘+Q Quitter LibreOffice

F11 ⌘+T Ouvre l’onglet Styles du volet latéral

La documentation française de LibreOffice est disponible à
https://wiki.documentfoundation.org/Documentation/Publications/fr
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Imprimer

Impression rapide

Pour imprimer rapidement un classeur, cliquez sur le bouton Imprimer directement  de la barre
d’outils Standard pour envoyer la totalité du document à l’imprimante par défaut définie pour votre 
ordinateur.

Remarque

Vous pouvez modifier l’action de l’icône Imprimer directement pour envoyer le document à 
l’imprimante définie pour celui-ci au lieu de l’imprimante par défaut de l’ordinateur. Ouvrez la
page Chargement/enregistrement – Général de la boîte de dialogue Options (Outils > Op-
tions) et cochez l’option Charger les paramètres d’impression avec le document.

Conseil

Après la première installation de LibreOffice, par défaut, l’icône Imprimer directement n’ap-
paraît pas dans la barre d’outils Standard. Vous pouvez cependant l’y ajouter en suivant les 
instructions du chapitre 14, Paramétrer et personnaliser Calc.

Impression contrôlée

Pour avoir plus de contrôle sur l’impression, sélectionnez Fichier > Imprimer dans la barre de 
menu ou appuyez sur Ctrl+P pour ouvrir la boîte de dialogue Imprimer (Figure 1).

Remarque

Les options sélectionnées dans la boîte de dialogue Imprimer ne s’appliquent qu’à l’impres-
sion du document ouvert.

Pour spécifier des paramètres d’impression par défaut pour LibreOffice, ouvrez les pages 
LibreOffice > Impression et LibreOffice Calc > Imprimer de la boîte de dialogue Options (Ou-
tils > Options). Voir le chapitre 14, Paramétrer et personnaliser Calc, pour les détails.

La boîte de dialogue Imprimer possède plusieurs onglets où vous pouvez sélectionner toute une 
gamme d’options décrites ci-dessous. Selon le système d’exploitation de votre ordinateur, le 
nombre et la disposition de ces onglets peuvent être différents de ceux des illustrations de ce cha-
pitre. Dans certaines installations, mais pas toutes, un bouton Plus d’options apparaît dans la 
boîte de dialogue Imprimer.

La boîte de dialogue Imprimer comporte une option Aperçu qui vous permet d’activer ou non un 
aperçu de l’aspect de la page de données imprimée. Celui-ci se trouve dans la partie gauche de la 
boîte de dialogue, au-dessus de l’option. À côté de celle-ci, des contrôles vous permettent de vous
déplacer d’une page à l’autre du classeur.
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Figure 1 : l’onglet Général de la boîte de dialogue Imprimer.

L’onglet Général

Dans l’onglet Général de la boîte de dialogue Imprimer (Figure 1), vous pouvez faire votre choix 
parmi les options suivantes :

Section Imprimante
Sélectionnez l’imprimante utilisée dans la liste des imprimantes disponibles,

Cliquez sur le bouton Propriétés pour pouvoir effectuer les réglages nécessaires de l’impri-
mante choisie. Les options disponibles pour cela dépendent de votre imprimante et de votre 
système.

Section Plage et exemplaires
Définissez ici les feuilles et les pages à imprimer, le nombre de copies à réaliser, s’il faut im-
primer d’un seul côté ou des deux côtés de la feuille, s’il faut les assembler et dans quel 
ordre les imprimer (voir « Sélectionner ce que l’on veut imprimer », page 4),
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Section Mise en page
Définissez les options de mise en page, telles que la taille du papier, son orientation, le 
nombre de pages imprimées par feuille, l’ordre dans lequel elles seront imprimées et si elles 
doivent être entourées par une bordure.

L’onglet LibreOffice Calc

Dans l’onglet LibreOffice Calc de la boîte de dialogue Imprimer (Figure 2), vous pouvez choisir 
d’ignorer ou non les pages vides au cours de l’impression du classeur.

Figure 2 : l’onglet LibreOffice Calc de la boîte de dialogue Imprimer.

Le bouton Plus d’options

Cliquez sur le bouton Plus d’options pour ouvrir la boîte de dialogue Plus d’options d’impression 
(Figure 3) où vous pouvez décider de créer des tâches d’impression séparées pour les sorties as-
semblées.

Figure 3 : l’onglet Options de la boîte de dialogue Imprimer.

Imprimer plusieurs pages sur une seule feuille de papier

Vous pouvez imprimer plusieurs pages d’un document sur une seule feuille de papier. Pour cela :

 1) Sélectionnez Fichier > Imprimer dans la barre de menu, appuyez sur Ctrl+P ou cliquez 
sur l’icône Imprimer  dans la barre de menu Standard pour ouvrir la boîte de dialogue Im-
primer, puis l’onglet Standard.

 2) Dans la section Mise en page (Figure 4), choisissez, dans la liste déroulante, le nombre de 
pages à imprimer par feuille. La vignette à gauche de la boîte de dialogue Imprimer montre 
l’aspect qu’aura le document imprimé.

 3) Quand vous imprimez plus de 2 pages par feuilles, vous pouvez choisir l’ordre dans lequel 
elles sont imprimées sur la feuille.

 4) Pour délimiter chaque page sur la feuille, cochez Dessiner une bordure autour de chaque 
page.
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 5) Cliquez sur le bouton OK.

Figure 4 : Imprimer plusieurs pages sur une feuille de papier.

Sélectionner ce que l’on veut imprimer

En plus d’imprimer un classeur dans sa totalité, vous pouvez choisir d’imprimer des feuilles indivi-
duelles, des groupes de feuilles ou des sélections de cellules.

Pour imprimer une seule feuille :

 1) Dans le classeur, sélectionnez la feuille à imprimer en cliquant sur son onglet.

 2) Choisissez Fichier > Imprimer dans la barre de menu, appuyez sur Ctrl+P ou cliquez sur 
l’icône Imprimer  dans la barre de menu Standard.

 3) Dans la liste déroulante Dont de la section Plage et exemplaires de la boîte de dialogue Im-
primer (Figure 1), choisissez Imprimer les feuilles sélectionnées.

 4) Cliquez sur OK.

Pour imprimer une série de feuilles :

 1) Dans le classeur, sélectionnez les feuilles à imprimer.

 2) Choisissez Fichier > Imprimer dans la barre de menu, appuyez sur Ctrl+P ou cliquez sur 
l’icône Imprimer  dans la barre de menu Standard.

 3) Dans la liste déroulante Dont de la section Plage et exemplaires de la boîte de dialogue Im-
primer (Figure 1), choisissez Imprimer les feuilles sélectionnées.

 4) Cliquez sur OK.

Pour imprimer une sélection de cellules :

 1) Dans le classeur, sélectionnez les cellules à imprimer.

 2) Choisissez Fichier > Imprimer dans la barre de menu, appuyez sur Ctrl+P ou cliquez sur 
l’icône Imprimer  dans la barre de menu Standard.

 3) Dans la liste déroulante Dont de la section Plage et exemplaires de la boîte de dialogue Im-
primer (Figure 1), cochez Imprimer les cellules sélectionnées.

 4) Cliquez sur OK.

4 | Chapitre 6 – Imprimer, exporter, envoyer par courriel et signer



Imprimer en niveaux de gris (avec une imprimante couleur)

Il peut arriver que vous souhaitiez imprimer des documents en niveaux de gris sur une imprimante 
couleur. Plusieurs solutions sont possibles.

Remarque

Certaines imprimantes en couleurs peuvent imprimer en couleurs indépendamment des pa-
ramètres que vous définissez.

Pour imprimer un seul fichier, vous pouvez modifier la configuration de l’imprimante pour imprimer 
en noir et blanc ou en niveaux de gris :

 1) Choisissez Fichier > Imprimer dans la barre de menu, appuyez sur Ctrl+P ou cliquez sur 
l’icône Imprimer  dans la barre de menu Standard pour ouvrir la boîte de dialogue Impri-
mer.

 2) Cliquez sur le bouton Propriétés pour ouvrir la boîte de dialogue de Propriétés de l’impri-
mante. Les choix possibles varient d’une imprimante à l’autre, mais vous devriez trouver des 
options de paramétrage des couleurs. Voyez l’aide ou le guide de l’utilisateur de votre impri-
mante pour plus d’informations.

 3) Parmi les choix possibles, vous pouvez trouver noir et blanc ou niveaux de gris. Sélectionnez
niveaux de gris.

 4) Cliquez sur OK pour confirmer votre choix et revenir à la boîte de dialogue Imprimer.

 5) Cliquez sur OK pour imprimer le document.

Vous pouvez modifier la configuration de LibreOffice pour imprimer en niveaux de gris les textes et
objets graphiques en couleur :

 1) Sélectionnez Outils > Options pour ouvrir la boîte de dialogue Option puis choisissez la 
page LibreOffice – Impression.

 2) Cochez l’option Convertir les couleurs en niveaux de gris. Cliquez sur OK pour enregistrer la 
modification.

! Attention

Cette modification des options d’impression ne s’applique pas seulement à Calc, mais à 
tous les modules de LibreOffice.

Aperçu des pages avant impression

Pour utiliser l’aperçu avant impression dans Calc :

 1) Choisissez Fichier > Aperçu, cliquez sur le bouton Aperçu  dans la barre d’outils Stan-
dard ou appuyez sur Ctrl+Maj+O. Calc affiche alors la barre d’outils Aperçu à la place de la
barre d’outils Formatage.

Figure 5 : La barre d’outils Aperçu
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 2) Pour imprimer le document à partir de cette vue, choisissez Fichier > Imprimer dans la 
barre de menu, appuyez sur Ctrl+P ou cliquez sur l’icône Imprimer ( ), dans la barre 
d’outils Standard, pour ouvrir la boîte de dialogue Imprimer.

 3) Choisissez les options d’impression et cliquez sur le bouton OK.

 4) Cliquez de nouveau sur le bouton Aperçu  dans la barre d’outils Standard ou sur le bou-
ton Fermer l’aperçu  de la barre d’outils Aperçu pour revenir à la vue normale du clas-
seur.

Utiliser les zones d’impression

Vous pouvez définir les plages de cellules du classeur à imprimer ou à exporter dans un fichier 
PDF. Les cellules de la feuille qui ne font pas partie d’une zone d’impression ne sont ni imprimées 
ni exportées. De plus les feuilles sans zone d’impression définie ne sont ni imprimées ni exportées.

Définir et imprimer une zone d’impression

Pour définir une zone d’impression et remplacer toute zone d’impression déjà définie :

 1) Sélectionnez la plage de cellules qui sera la zone d’impression.

 2) Choisissez Format > Zones d’impression > Définir dans la barre de menu. Des lignes de 
sauts de page automatiques, qui définissent les cellules incluses dans la zone d’impression, 
s’affichent sur l’écran.

 3) Cliquez sur l’icône Imprimer directement  de la barre d’outils Standard ou ouvrez la boîte
de dialogue Imprimer et cliquez sur OK pour imprimer la zone d’impression définie.

Conseil

Vous pouvez vérifier la zone d’impression en utilisant le bouton Aperçu  dans la barre 
d’outils Standard ou l’aperçu de la boîte de dialogue Imprimer. Calc n’affichera que les cel-
lules dans la zone d’impression. Voir « Visualiser les zones d’impression », page 7.

Modifier une zone d’impression

Vous pouvez modifier à tout moment la zone d’impression, par exemple pour lui ajouter ou lui enle-
ver des cellules, ou pour définir les lignes et les colonnes à répéter sur toutes les pages (comme 
les lignes et colonnes d’en-tête).

 1) Sélectionnez Format > Zones d’impression > Éditer dans la barre de menu pour ouvrir la 
boîte de dialogue Éditer les zones d’impression (Figure 6).
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Figure 6 : la boîte de dialogue Éditer les zones d’impression.

 2) Si vous cliquez dans la boîte de saisie Zones d’impression, les différentes plages de la 
zone d’impression sont entourées en couleurs différentes (bleu pour la première, rouge pour 
la deuxième, magenta pour la suivante…) comme sur la Figure 7.

Figure 7 : la première plage de la zone d’impression est entourée en bleu,
la seconde en rouge.

 3) Pour ajouter de nouvelles cellules à la zone déjà définie, tapez un point-virgule1 à la fin du 
contenu de la boîte de saisie Zones d’impression pour le séparer de la plage à ajouter. Sé-
lectionnez celle-ci dans le classeur (après avoir cliqué sur le bouton à droite de la boîte de 
saisie) ou tapez sa référence en utilisant le format des plages déjà définies. N’oubliez pas de
séparer les références des cellules par un caractère deux-points.

 4) Pour supprimer une plage de cellule de la zone d’impression, effacez-la de la boîte de saisie 
Zones d’impression. Faites attention que les autres plages soient bien séparées par un 
point-virgule1 et qu’il n’y en ait pas à la fin de la suite de plages.

 5) Cliquez sur OK pour enregistrer les modifications et refermer la boîte de dialogue.

Visualiser les zones d’impression

Quand les zones d’impression ont été définies, elles sont automatiquement formatées avec des 
sauts de page. Pour voir ceux-ci, sélectionnez Affichage > Sauts de page dans la barre de menu 
pour ouvrir l’aperçu (Figure 8).

Les zones d’impression sont par défaut entourées d’une bordure bleue et contiennent en leur 
centre leur numéro de page en gris très clair. Les parties non imprimées du classeur apparaissent 
normalement sur un fond gris foncé.

Pour quitter cet aperçu des sauts de page, sélectionnez Affichage > Normal dans la barre de 
menu.

1 Ce séparateur dépend de la langue. Il est défini dans la page LibreOffice Calc – Formule de la boîte de dialogue 
Options, par le contenu de la boîte de saisie Fonction de la section Séparateurs.
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Figure 8 : aperçu des sauts de page.

Zones d’impression nommées

En plus de définir une zone pour chaque tâche d’impression, vous pouvez aussi définir une plage 
de cellules utilisée de façon répétée, sans avoir à sélectionner à chaque fois les cellules. Cela se 
révèle utile si différentes zones d’un classeur étendu doivent être imprimées pour des rapports dif-
férents ; plusieurs zones d’impression nommées peuvent être définies pour correspondre à ce be-
soin.

Définir et nommer une zone

 1) Sélectionnez les cellules que vous souhaitez définir comme zone d’impression nommée puis
choisissez Feuille > Plages et expressions nommées > Définir dans la barre de menu 
pour ouvrir la boîte de dialogue Définir un nom (Figure 9). Les cellules sélectionnées sont in-
diquées dans la boîte de saisie Plage ou expression de formule.

Vous pouvez aussi commencer par ouvrir la boîte de dialogue puis sélectionner la plage de 
cellules à nommer après avoir cliqué sur le bouton situé à l’extrémité du champ de saisie 
Plage ou expression de formule.

Figure 9 : la boîte de dialogue Définir un nom.

 2) Tapez un nom pour la zone dans la boîte de saisie Nom. N’utilisez pour cela que des lettres, 
des chiffres et des caractères soulignés (_), ni espace, ni tiret, ni autre caractère.
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 3) Si nécessaire, vous pouvez modifier ou définir la plage de cellules sélectionnées dans la 
boîte de saisie Plage ou expression de formule. Voir « Modifier une zone d’impression », 
page 6, pour plus d’informations.

 4) Vérifiez que l’option choisie dans Étendue est bien Document (global) avant de définir la 
plage comme zone d’impression.

 5) Cochez Zone d’impression dans la section Options de la plage.

 6) Cliquez sur Ajouter pour accepter les données et refermer la boîte de dialogue.

Imprimer une zone nommée

Pour sélectionner une plage nommée et l’imprimer :

 1) Sélectionnez Format > Zones d’impression > Éditer dans la barre de menu pour ouvrir la 
boîte de dialogue Éditer les zones d’impression (Figure 10).

Figure 10 : Choix d’une zone nommée à imprimer.

 2) Choisissez la zone d’impression nommée dans la liste déroulante Zones d’impression.

 3) Cliquez sur OK pour refermer la boîte de dialogue.

 4) Ouvrez la boîte de dialogue Imprimer qui n’affiche maintenant que la zone d’impression nom-
mée dans son aperçu. Cliquez sur OK.

Supprimer une zone d’impression nommée

Pour supprimer une zone d’impression nommée qui n’est plus nécessaire :

 1) Sélectionnez Feuille > Plages et expressions nommées > Gérer dans la barre de menu 
pour ouvrir la boîte de dialogue Gérer les noms (Figure 11).

 2) Choisissez la zone d’impression nommée que vous souhaitez supprimer et vérifiez dans la 
section Options de la plage qu’il s’agit bien d’une zone d’impression.

 3) Cliquez sur Supprimer puis sur OK pour refermer la boîte de dialogue.

Utiliser les zones d’impression | 9



Figure 11 : la boîte de dialogue Gérer les noms.

Supprimer des zones d’impression

Il peut devenir nécessaire de supprimer une zone d’impression définie, par exemple s’il faut impri-
mer la feuille entière ou si on ne veut plus imprimer certaines des plages ajoutées.

Sélectionner Format > Zones d’impression > Effacer dans la barre de menu pour supprimer 
toutes les plages d’impression définie dans le classeur, sauf les zones d’impression nommées. 
Après cela, les lignes des sauts de page par défaut pour la taille de papier choisie apparaîtront sur 
l’écran.

Pour supprimer les zones d’impression nommées, voyez « Supprimer une zone d’impression 
nommée » ci-dessus.

Répéter l’impression de lignes ou de colonnes

Si un classeur est imprimé sur plusieurs pages, vous pouvez que certaines lignes ou colonnes (les
en-têtes, par exemple) seront imprimées sur chaque page.

Avec les zones d’impression

 1) Sélectionnez Format > Zones d’impression > Éditer dans la barre de menu pour ouvrir la 
boîte de dialogue Éditer les zones d’impression (Figure 12).
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Figure 12 : lignes et colonnes à imprimer sur toutes les pages.

 2) Dans la boîte de saisie Lignes à répéter, saisissez les références des lignes à imprimer sur 
toutes les pages. Par exemple, pour répéter les lignes 1 à 4, tapez $1:$4. Dans la liste dé-
roulante adjacente, l’option passe automatiquement de – aucun(e) – à – défini par l’utilisa-
teur –.

Vous pouvez aussi placer le curseur dans cette boîte de saisie puis sélectionner avec la sou-
ris les lignes à répéter. Il n’est pas nécessaire de sélectionner toute la ligne.

 3) La procédure est identique pour sélectionner les colonnes dans la section Colonnes à répé-
ter.

 4) Cliquez sur OK pour enregistrer les modifications et refermer la boîte de dialogue.

Avec les zones d’impression nommées

Il est aussi possible de définir des zones d’impression nommées utilisées pour répéter l’impression
de lignes ou de colonnes :

 1) Définissez et nommez les lignes et les colonnes que vous désirez imprimer sur toutes les 
pages. Voyez « Zones d’impression nommées », page 8, pour plus d’informations.

 2) Cochez Répéter la colonne ou Répéter la ligne dans la section Options de la plage de la 
boîte de dialogue Définir un nom (Figure 9 page 8).

 3) Cliquez sur Ajouter pour enregistrer les données et refermer la boîte de dialogue.

 4) Choisissez Format > Zones d’impression > Éditer dans la barre de menu pour ouvrir la 
boîte de dialogue Éditer les zones d’impression (Figure 12).

 5) Sélectionnez la zone d’impression nommée dans les listes déroulantes Lignes à répéter ou 
Colonnes à répéter.

 6) Cliquez sur OK pour enregistrer les modifications et refermer la boîte de dialogue.

Sauts de page

Bien que les zones d’impression soient des outils puissants, il peut parfois être nécessaire d’ajus-
ter manuellement les sauts de page pour que le classeur soit imprimé comme vous le désirez. 
Vous pouvez insérer deux types de sauts de page dans un classeur :
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• les sauts de ligne sont des sauts de page horizontaux qui s’insèrent au-dessus d’une cellule 
sélectionnée dans une ligne. Par exemple, si la cellule sélectionnée est la cellule H15, le 
saut de ligne est créé entre les lignes 14 et 15 ;

• les sauts de colonne sont des sauts de page verticaux qui s’insèrent à gauche de la cellule 
sélectionnée dans une colonne. Par exemple, si la cellule sélectionnée est la cellule H15, le 
saut de colonne est créé entre les colonnes G et H.

Quand un saut de page manuel est inséré, il apparaît sous forme d’une ligne bleue ou d’une ligne 
épaisse entre les lignes ou les colonnes de la grille. Son apparence dépend des paramètres de 
votre ordinateur. Pour les voir plus facilement, vous pouvez la modifier. Ouvrez la page LibreOffice
– Couleurs de l’interface de la boîte de dialogue Options (Outils > Options) et descendez à la 
section Classeur où vous pourrez modifier leur couleur.

Insérer des sauts de page

 1) Sélectionnez la cellule où vous voulez insérer un saut de page manuel dans le classeur.

 2) Choisissez Feuille > Insérer un saut de page dans la barre de menu.

 3) Dans le sous-menu, sélectionnez Saut de ligne pour insérer un saut de page au-dessus de 
la cellule ou Saut de colonne pour insérer un saut de page à gauche de la cellule.

Vous pouvez aussi sélectionner Affichage > Saut de page dans la barre de menu, faire un clic 
droit sur le classeur et choisir Saut de ligne ou Saut de colonne dans le menu contextuel. N’ou-
bliez pas de revenir à la vue normale du classeur (Affichage > Normal).

Supprimer des sauts de page

 1) Sélectionnez la cellule dont vous souhaitez supprimer le saut de page manuel.

 2) Choisissez Feuille > Supprimer le saut de page dans la barre de menu.

 3) Dans le sous-menu, sélectionnez Saut de ligne pour supprimer un saut de page au-dessus 
de la cellule ou Saut de colonne pour supprimer un saut de page à gauche de la cellule.

Supprimer tous les sauts de page

Plusieurs sauts de ligne ou de colonne peuvent exister dans le même classeur. Si vous souhaitez 
supprimer tous les sauts de page du classeur :

 1) Sélectionnez Affichage > Saut de page dans la barre de menu.

 2) Faites un clic droit sur le classeur et choisissez Supprimer les sauts de page dans le menu
contextuel pour enlever tous les sauts de page manuel du classeur.

 3) N’oubliez pas de revenir à la vue normale du classeur (Affichage > Normal).

Options d’impression des styles de page

Quand vous utilisez des styles de page dans votre classeur, vous pouvez y inclure des options 
d’impression, par exemple l’ordre des pages, les éléments à imprimer, l’échelle, etc. L’utilisation 
des styles de page vous permet de définir et de changer rapidement les options d’impression des 
différentes feuilles du classeur. Voyez le chapitre 4, Utiliser les styles et les modèles dans Calc, 
pour plus d’informations sur les styles de page.
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Vérifiez que vous avez sélectionné la bonne feuille dans le classeur avant de définir les options 
d’impression. Sélectionnez Format > Page dans la barre de menu pour ouvrir la boîte de dialogue 
Style de page puis cliquez sur l’onglet Feuille (Figure 13) pour paramétrer les options d’impression 
du style de page. Le titre de la boîte de dialogue précise le nom du style de page que vous êtes 
sur le point de modifier.

Figure 13 : l’onglet Feuille de la boîte de dialogue Style de page.

Ordre des pages
Définissez l’ordre dans lequel les données d’une feuille sont imprimées et les pages numéro-
tées quand elles ne tiennent pas sur une seule page. Un aperçu de l’ordre des pages est vi-
sible en haut à gauche de la boîte de dialogue sur la Figure 13.

– De haut en bas, puis vers la droite : les données sont imprimées verticalement jusqu’en 
bas de la colonne de gauche puis dans la colonne de droite.

– De gauche à droite, puis vers le bas : les données sont imprimées horizontalement jus-
qu’au bord droit puis en dessous.

– Premier numéro de page cochez cette option et saisissez le numéro de la première page 
si vous voulez commencer avec un autre numéro que 1.

Imprimer
Définissez ici les éléments du classeur qui doivent être imprimés.

– En-têtes de colonne et de ligne imprime les numéros de lignes et les lettres des colonnes.

– Grille imprime les bordures des cellules pour former une grille. Pour l’affichage à l’écran, 
définissez votre préférence dans la page LibreOffice Calc – Affichage de la boîte de dia-
logue Options (Outils > Options) dans la liste Lignes de la grille.

– Commentaires imprime les commentaires définis dans le classeur. Ils seront imprimés sur
une page séparée, accompagnés de la référence de la cellule correspondante.
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– Objets/Images imprime tous les objets imprimables et les images insérés dans le clas-
seur.

– Diagrammes imprime les diagrammes insérés dans le classeur.

– Objets de dessin imprime tous les dessins créés avec les outils de LibreOffice.

– Formules imprime les formules contenues dans les cellules à la place de leurs résultats.

– Valeurs zéro précise que les cellules contenant une valeur zéro sont imprimée avec un 
zéro (0).

Échelle
Vous définissez ici l’échelle qu’aura le classeur imprimé sur la page en choisissant une op-
tion dans la liste déroulante Mode d’échelle. Les contrôles appropriés apparaîtront sous la 
liste.

– Réduire / agrandir l’impression : vous pouvez spécifier un facteur d’échelle en pourcen-
tage dans la boîte de saisie.

– Adapter les zones d’impression en largeur et en hauteur : vous spécifiez le nombre maxi-
mum de feuilles de papier sur lesquelles les pages qui ont ce style seront imprimées dans
le sens horizontal (Largeur en pages) et vertical (Hauteur en pages).

Les zones d’impression sont toujours mises à l’échelle de manière proportionnelle, si bien
que le nombre de page peut être inférieur à celui spécifié.

Vous pouvez effacer le contenu d’une des boîtes de saisie pour indiquer qu’il faut utiliser, 
pour cette dimension, autant de pages que nécessaire. Si vous effacer le contenu des 
deux, le facteur d’échelle sera 100 %.

– Adapter les zones d’impression au nombre de page : vous spécifiez, dans le champ 
Nombre de pages, le nombre maximum de feuilles de papier sur lesquelles les pages qui 
ont ce style seront imprimées. L’échelle sera alors réduite autant que nécessaire pour ne 
pas le dépasser

En-têtes et pieds de pages

Les en-têtes et pieds de page sont des éléments de texte imprimés en haut ou en bas de chaque 
feuille imprimée, hors de la zone d’impression des données. Ils se paramètrent de la même ma-
nière et peuvent avoir un contenu différent pour les pages de gauche et de droite qui utilisent le 
même style.

Paramétrer les en-têtes et pieds de page

Pour activer les en-têtes ou les pieds de page dans votre classeur :

 1) Sélectionnez la feuille dont vous souhaitez activer l’en-tête ou le pied de page.

 2) Choisissez Format > Page dans la barre de menu pour ouvrir la boîte de dialogue Style de 
page puis cliquez sur l’onglet En-tête ou Pied de page (Figure 14). Les deux onglets sont 
identiques.

 3) Cochez Activer l’en-tête ou Activer le pied de page.

 4) Saisissez les valeurs des autres options selon vos désirs. Elles sont décrites ci-dessous.
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 5) Cliquez sur OK pour enregistrer les modifications et refermer la boîte de dialogue.

Figure 14 : l’onglet En-tête de la boîte de dialogue Style de page.

Activer l’en-tête ou Activer le pied de page
Cochez cette option pour ajouter un en-tête ou un pied de page au style que vous modifiez.

Même contenu sur les pages de droite et de gauche
Si cette option est cochée, les pages de droite et de gauche partagent le même contenu. 
Pour leur affecter un en-tête ou un pied de page différent, décochez-la et cliquez sur Éditer. 
Voir « Contenu des en-têtes et pieds de page » ci-dessous pour plus d’informations.

Marge de gauche
Saisissez la distance entre la marge de gauche et le bord gauche de l’en-tête ou du pied de 
page.

Marge de droite
Saisissez la distance entre la marge de droite et le bord droit de l’en-tête ou du pied de page.

Espacement
Saisissez la distance entre le bas de l’en-tête et le haut de la zone imprimée ou le haut du 
pied de page et le bas de la zone imprimée.

Hauteur
Saisissez la hauteur de l’en-tête ou du pied de page.

Adaptation dynamique de la hauteur
Cochez cette option pour que la hauteur de l’en-tête ou du pied de page s’adapte automati-
quement à son contenu.

Aperçu
Une figure, à droite de la boîte de dialogue, vous donne un aperçu des résultats de vos 
choix.

Plus
Ce bouton ouvre une boîte de dialogue Bordure / Arrière-plan où vous pouvez définir l’appa-
rence des bordures et de l’arrière-plan de l’en-tête ou du pied de page. Voir le chapitre 4, 
Utiliser les styles et les modèles dans Calc, pour plus d’informations.
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Éditer
Ce bouton ouvre la boîte de dialogue En-tête ou Pied de page où vous pouvez ajouter, modi-
fier ou formater le texte placé dans l’en-tête ou le pied de page. Voir ci-dessous pour plus 
d’informations.

Contenu des en-têtes et pieds de page

Dans un classeur de Calc, les en-têtes et les pieds de page disposent de trois colonnes de texte 
qui peuvent soit être vides, soit avoir un contenu différent des autres colonnes.

 1) Sélectionnez la feuille dont vous souhaitez activer l’en-tête ou le pied de page.

 2) Choisissez Format > Page dans la barre de menu pour ouvrir la boîte de dialogue Style de 
page puis cliquez sur l’onglet En-tête ou Pied de page (Figure 14). Voir « Paramétrer les en-
têtes et pieds de page » ci-dessus.

 3) Cliquez sur le bouton Éditer pour ouvrir la boîte de dialogue En-tête ou Pied de page (Figure
15). Si l’option Même contenu sur les pages de droite et de gauche n’est pas cochée dans la
boîte de dialogue Style de page, celle-ci aura des onglets où vous pourrez définir le contenu 
de l’en-tête ou du pied de page des pages de droite et de gauche.

Figure 15 : le dialogue En-tête

 4) Vous pouvez sélectionner une option dans la liste déroulante En-tête (ou Pied de page) par-
mi une série d’options standards.

 5) Pour saisir un contenu personnalisé, cliquez dans l’une des zones de saisie et tapez votre 
texte ou cliquez sur l’un des boutons de la section En-tête (ou Pied de page) personnalisé. 
Leurs fonctions sont présentées ci-dessous.

 6) Pour modifier l’apparence du texte dans l’en-tête ou le pied de page, cliquez sur le bouton 
Attributs de texte  pour ouvrir une boîte de dialogue Attributs de texte où vous pourrez 
définir la police, les effets de caractères et leurs positions.

 7) Cliquez sur OK pour enregistrer les modifications des attributs du texte et refermer cette 
boîte de dialogue.

 8) Cliquez sur OK pour enregistrer le contenu de l’en-tête ou du pied de page et refermer la 
boîte de dialogue En-tête (ou Pied de page).
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 9) Cliquez sur OK pour enregistrer les modifications de l’en-tête ou du pied de page dans le 
style de page et refermer la boîte de dialogue correspondante.

Les boutons de la section En-tête (ou Pied de page) personnalisé ont, de gauche à droite, les 
fonctions suivantes :

Attributs de texte
Ouvre une boîte de dialogue Attributs de texte où vous pourrez définir la mise en forme d’un 
texte nouveau ou sélectionné. Celle-ci contient des onglets pour paramétrer la Police, les Ef-
fets de caractères et leur Position.

Titre
Déroule une liste où vous pouvez choisir d’insérer dans la zone sélectionnée un emplace-
ment pour le Titre, le Nom de fichier ou le Chemin/Nom de fichier. Si aucun titre n’a été défini
pour le classeur, le nom du fichier qui le contient sera inséré à sa place.

Nom de feuille
Insère dans la zone sélectionnée un emplacement pour le nom de la feuille sélectionnée 
dans le classeur.

Page
Insère dans la zone sélectionnée un emplacement pour le numéro de page. Cela permet une
numérotation continue des pages du classeur.

Pages
Insère dans la zone sélectionnée un emplacement pour le nombre total de pages du clas-
seur.

Date
Insère dans la zone sélectionnée un emplacement pour la date courante qui sera répétée 
dans l’en-tête ou le pied de chaque page du classeur.

Heure
Insère dans la zone sélectionnée un emplacement pour l’heure courante qui sera répétée 
dans l’en-tête ou le pied de chaque page du classeur.

Exporter en PDF

Calc peut exporter des documents en PDF (Portable Document Format). Ce format de fichier est 
un standard industriel idéal pour envoyer un fichier à quelqu’un qui pourra le lire avec Adobe Rea-
der ou tout autre lecteur de PDF.

! Attention

Un document au format PDF n’est pas protégé par défaut contre la falsification ou la modifi-
cation. Son contenu peut être édité grâce à des outils logiciels spécialisés et par LibreOffice 
Draw.

Remarque

Contrairement à la commande Enregistrer sous, la commande Exporter écrit une copie du
document ouvert dans un nouveau fichier au format choisi, mais garde ce document ouvert 
dans son format d’origine.
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Exportation rapide en PDF

Cliquez sur l’icône Export direct au format PDF  de la barre d’outils Standard pour exporter le 
classeur entier avec les derniers paramètres utilisés dans la boîte de dialogue Options PDF (voir 
ci-dessous). Il vous est demandé de saisir le nom et l’emplacement du fichier PDF, mais vous n’au-
rez pas l’occasion de choisir la plage de pages, la compression des images ni les autres options.

Contrôler le contenu et la qualité du fichier PDF

Pour un meilleur contrôle du contenu et de la qualité du PDF obtenu, utilisez Fichier > Exporter 
au format PDF. La boîte de dialogue Options PDF s’ouvre. Elle possède six onglets (Général, Vue
initiale, Interface utilisateur, Liens, Sécurité et Signatures numériques). Choisissez les paramètres 
appropriés puis cliquez sur Exporter après quoi vous devrez saisir l’emplacement et le nom du fi-
chier PDF à créer et de cliquer sur Enregistrer pour exporter le fichier.

La boîte de dialogue Options PDF – onglet Général

Dans l’onglet Général (Figure 16), vous pouvez choisir les pages à inclure dans le PDF, le type de 
compression à utiliser pour les images (qui affecte leur qualité dans le PDF) et d’autres options. 
Pour plus d’informations, voir le Guide du débutant ou l’aide. Dans la plupart des cas, les valeurs 
par défaut conviennent.

Figure 16 : L’onglet Général de la boîte de dialogue Options PDF.

Plage
– Tout : exporte la totalité du document en PDF.

– Pages : pour exporter un intervalle de pages, utilisez le format 3-6 (pages de 3 à 6). Pour 
exporter des pages individuelles, utilisez le format 7 ; 9 ; 11 (pages 7, 9 et 11). Il est aussi 
possible d’exporter une combinaison d’intervalles et de pages individuelles en utilisant un 
format comme 3-6 ; 8 ; 10 ; 12.

– Sélection/Feuille(s) sélectionnée(s) : exporte tout ce qui est sélectionné (une feuille ou 
une partie de feuille).
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– Afficher le PDF après export : si cette option est cochée, votre lecteur de PDF par défaut 
va s’ouvrir pour afficher le fichier PDF qui vient d’être exporté.

Images
– Compression sans perte : les images sont incorporées sans aucune perte de qualité. 

Avec des photographies, il peut en résulter de gros fichiers. Cette option est recomman-
dée pour les autres types d’images ou d’objets graphiques.

– Compression JPEG : elle offre une qualité plus ou moins grande entre 1 et 100 %. Une 
qualité de 90 % est bien adaptée aux photographies (petite taille de fichier, perte de quali-
té à peine perceptible).

– Réduire la résolution des images : sélectionnez l’option souhaitée dans la liste déroulante.
Les images à faible DPI (Dot Per Inch : point par pouce) ont une qualité plus faible. Pour 
les regarder sur l’écran d’un ordinateur, une résolution de 72 dpi (sous Windows) ou 
96 dpi (sous GNU/Linux) est généralement suffisante, alors que pour l’impression il est 
souvent préférable d’utiliser au moins 300 ou 600 dpi selon les possibilités de l’impri-
mante. Une valeur élevée des DPI augmente fortement la taille du fichier exporté.

Filigrane
– Signer avec un filigrane : quand cette option est cochée, une couche transparente conte-

nant le texte que vous saisirez dans la boîte Texte apparaîtra sur chaque page du PDF.

Général
– PDF hybride (fichier ODF incorporé) : cochez cette option pour exporter le document 

comme fichier PDF contenant deux formats de fichiers : PDF et ODF. Dans les lecteurs de
PDF, il se comporte comme un fichier PDF normal et il reste totalement modifiable dans 
LibreOffice.

– Archive PDF/A (ISO 19005) : PDF/A est un standard ISO pour la conservation à long 
terme des documents en y incorporant toutes les informations nécessaires à une repro-
duction fidèle (telles que les polices) et en excluant d’autres éléments (y compris les for-
mulaires, la sécurité et l’encodage). Les balises PDF sont écrites. Sélectionnez la version 
du standard à utiliser : PDF/A-1b ou PDF/A-2b.

– PDF marqué (ajouter la structure du document) : les PDF marqués contiennent des infor-
mations sur la structure du contenu du document. Cela peut aider à afficher ce document 
sur des appareils possédant des écrans différents ou si on utilise un logiciel de lecture 
d’écran. Parmi les marques exportées, il y a la table des matières, les hyperliens et les 
contrôles. Cette option peut augmenter de façon significative la taille des fichiers.

– Créer un formulaire PDF – Format d’envoi : si vous cochez cette option, choisissez le for-
mat des formulaires envoyés depuis le fichier PDF dans la liste déroulante.

– Autoriser les doublons de noms de champs : si cette option est cochée, le même nom 
peut être utilisé pour plusieurs champs dans le fichier PDF produit. Sinon, les noms de 
champs seront exportés avec des noms uniques générés à cette fin.

– Exporter les repères de texte : cette option n’est généralement pas utilisée avec Calc.

– Commentaires en tant qu’annotations PDF : exporte les commentaires sous forme de 
notes PDF. Ce n’est peut-être pas ce que vous désirez !

– Export feuille entière : cette option vous permet d’exporter le contenu de chaque feuille de
votre classeur Calc comme une page du fichier PDF. Cette fonction n’a pas pour but d’of-
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frir un document à imprimer mais de vous permettre de voir et réviser facilement le conte-
nu entier d’un classeur dans un fichier PDF, sans le découpage habituel des feuilles en 
pages imprimables. Les pages d’aperçu auront des tailles différentes, comme celles des 
feuilles sources.

Remarque

Le choix de l’option Export feuille entière fait négliger par Calc de nombreux autres para-
mètres de la boîte de dialogue Options PDF.

– Exporter les pages vides insérées automatiquement : cette option n’est pas accessible 
dans Calc.

– Utiliser les XObjets de référence : les XObjets de référence permettent à un fichier PDF 
d’importer du contenu d’un autre. Vous trouverez plus d’informations à la section 8.10.4 
de la spécification PDF ISO 32000-2:2017 (https://www.iso.org/fr/standard/63534.html). Si
vous ne maîtrisez pas les XObjets de référence, ne cochez pas cette option.

La boîte de dialogue Options PDF – onglet Vue initiale

Dans l’onglet Vue Initiale (Figure 17), vous pouvez choisir comment le PDF s’ouvre par défaut 
dans le lecteur PDF. Les choix devraient se comprendre d’eux-mêmes.

Figure 17 : L’onglet Vue initiale de la boîte de dialogue Options PDF.

La boîte de dialogue Options PDF – onglet Interface utilisateur

Figure 18 : L’onglet Interface utilisateur de la boîte de dialogue Options PDF.
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Dans l’onglet Interface utilisateur (Figure 18), vous pouvez choisir d’autres options pour contrôler 
la façon dont le fichier sera affiché par un lecteur de PDF. Certains de ces choix sont particulière-
ment utiles si vous créez un PDF destiné à une présentation ou une borne interactive.

Options de fenêtre
– Redimensionner la fenêtre selon la page initiale : provoque l’adaptation de la fenêtre du 

lecteur de PDF aux dimensions de la première page du fichier.

– Centrer la fenêtre à l’écran : centre la fenêtre du lecteur de PDF sur l’écran de l’ordina-
teur.

– Ouvrir en mode plein écran : ouvre le lecteur de PDF en plein écran au lieu du mode fenê-
tré.

– Afficher le titre du document : affiche le titre du document dans la barre de titre du lecteur 
de PDF.

Transitions
Section non utilisée dans Calc.

Options d’interface utilisateur
– Masquer la barre de menu : masque la barre de menu du lecteur de PDF.

– Masquer la barre d’outils : masque la barre d’outils du lecteur de PDF.

– Masquer les contrôles de la fenêtre : masque les autres contrôles de la fenêtre du lecteur 
de PDF.

Repères de texte
– Tous les niveaux de repères de texte : affiche tous les niveaux de repères de texte à l’ou-

verture du fichier PDF.

– Niveaux de repères de texte visibles : choisissez le niveau (entre 1 et 10) jusqu’auquel les
repères de texte seront affichés à l’ouverture du fichier PDF.

La boîte de dialogue Options PDF – onglet Liens

Dans l’onglet Liens (Figure 19), vous pouvez définir la manière dont les repères de texte et les hy-
perliens sont exportés dans le PDF.

Figure 19 : L’onglet Liens de la boîte de dialogue Options PDF.
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Général
– Exporter les repères de texte comme destinations nommées : si vous avez défini des 

noms de feuille dans Calc, cette option les exporte en tant que « destinations nommées » 
auxquelles les pages Web et les documents PDF peuvent se référer.

– Convertir les références de document en cibles PDF : si vous avez défini des liens vers 
d’autres documents avec une extension OpenDocument (comme.odt,.ods ou.odp), cette 
option remplace ces extensions par.pdf dans le document PDF exporté.

– Exporter les URL relatives au système de fichier : si vous avez défini des liens relatifs 
dans un document, cette option les exporte dans le PDF. Voir « Hyperliens relatifs et ab-
solus » dans l’aide de Calc.

Liens entre documents
Cette option définit le comportement des liens sur lesquels vous cliquez dans les fichiers 
PDF. Choisissez une option parmi les suivantes :

– Mode par défaut : les liens PDF seront gérés comme il est spécifié dans votre système 
d’exploitation.

– Ouvrir avec un lecteur de PDF : utiliser l’application qui a servi à afficher le document PDF
pour ouvrir les documents PDF liés.

– Ouvrir avec un navigateur Internet : utiliser le navigateur Internet par défaut pour afficher 
les documents PDF liés.

La boîte de dialogue Options PDF – onglet Sécurité

L’exportation des PDF comporte des options pour encoder et définir des mots de passe quand 
vous exportez le classeur et créez le PDF. Cela permet aussi d’appliquer des restrictions d’impres-
sion et de définir si les modifications et la copie du fichier PDF sont autorisées.

Figure 20 : L’onglet Sécurité de la boîte de dialogue Options PDF.

Cliquez sur le bouton Définir les mots de passe pour ouvrir la boîte de dialogue de même nom 
(Figure 21) où vous pourrez saisir les mots de passe. Vous pouvez saisir un mot de passe pour 
ouvrir le fichier (section Déf. mot de passe d’ouverture) et un autre, facultatif, pour limiter ce que 
le lecteur peut faire avec le fichier PDF (section Déf. mot de passe d’autorisation).
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• Quand un mot de passe d’ouverture est défini, le PDF ne peut être ouvert qu’avec celui-ci. 
Une fois ouvert, l’utilisateur n’est soumis à aucune restriction sur ce qu’il peut faire (par 
exemple, l’imprimer, le copier ou le modifier).

• Quand un mot de passe d’autorisation est défini, le PDF peut être ouvert par n’importe qui, 
mais son utilisation peut être soumise à restrictions. Voir la Figure 20. Quand vous avez défi-
ni un mot de passe d’autorisation, les autres options de l’onglet Sécurité deviennent acces-
sibles.

• Si les deux types de mots de passe sont définis, le PDF ne peut être ouvert qu’avec le mot 
de passe correct et son utilisation peut être restreinte.

Les options de l’onglet Sécurité ne sont accessibles qu’après la création des mots de passe.

Remarque

Le paramétrage des autorisations n’a d’effet que si le lecteur de PDF de l’utilisateur le res-
pecte.

La Figure 21 montre la boîte de dialogue qui s’affiche quand vous cliquez sur le bouton Définir les
mots de passe dans l’onglet Sécurité de la boîte de dialogue Options PDF.

Figure 21 : Définir un mot de passe pour encoder un fichier PDF.

La boîte de dialogue Options PDF – onglet Signatures numériques

Cet onglet contient les options qui concernent l’exportation de PDF signés numériquement.

Les signatures numériques permettent d’assurer que le PDF a réellement été créé par son auteur 
initial (vous) et qu’il n’a pas été modifié depuis lors.

L’exportation de PDF signés utilise les clés et certificats X.509 déjà stockés dans votre dépôt de 
certificats par défaut ou sur une carte à puce. Sous Linux ou Mac OS le dépôt à utiliser peut être 
sélectionné dans la page LibreOffice > Sécurité > Chemin du certificat de la boîte de dialogue Op-
tions (cliquez sur Outils > Options dans la barre de menu) ; sous Windows, le dépôt de certificats 
par défaut est toujours utilisé. Si vous utilisez une carte à puce, elle doit être déjà configurée pour 
être utilisée par votre dépôt. Cela se fait normalement pendant l’installation de son logiciel. Les dé-
tails concernant l’utilisation de ces propriétés sortent du cadre de ce chapitre.
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Figure 22 : L’onglet Signatures numériques de la boîte de dialogue Options PDF.

• Utiliser ce certificat pour signer numériquement les documents PDF : cliquez sur Sélection-
ner pour ouvrir la boîte de dialogue Sélectionner le certificat où tous les certificats trouvés 
dans le dépôt sélectionné sont affichés. Si ce dépôt est protégé par un mot de passe, il vous 
est demandé. Quand vous utilisez une carte à puce protégée par un code PIN, celui-ci vous 
est aussi demandé.

Sélectionnez le certificat à utiliser pour signer numériquement le PDF exporté puis cliquez 
sur OK. Tous les autres champs de l’onglet ne sont accessibles qu’après le choix d’un certifi-
cat.

• Mot de passe du certificat : saisissez le mot de passe utilisé pour protéger la clé privée asso-
ciée au certificat choisi. C’est habituellement le mot de passe du dépôt. Si celui-ci a déjà été 
saisi dans la boîte de dialogue Sélectionner le certificat, le dépôt peut déjà être déverrouillé 
et ne pas redemander le mot de passe.

Si vous utilisez une carte à puce, entrez ici le code PIN. Certains logiciels de cartes à puce 
vous demanderont de nouveau ce code avant de signer.

• Emplacement, Information de contact, Raison : vous pouvez saisir des informations supplé-
mentaires facultatives concernant la signature numérique qui sera appliquée au PDF. Celles-
ci seront incorporées dans les champs appropriés du PDF et visibles par quiconque ouvrira 
le fichier. Tout ou partie de ces trois champs peut être laissé vide.

• Autorité d’horodatage : vous pouvez choisir l’URL d’une Autorité d’horodatage (Time Stamp-
ing Authority : TSA). Pendant le processus de signature du PDF, la TSA sera utilisée pour ob-
tenir la date et l’heure signées numériquement qui seront incorporées à la signature. Si quel-
qu’un ouvre le PDF, il pourra utiliser cette information pour vérifier quand le document a été 
signé.

La liste des URL des autorités d’horodatage qui peuvent être choisies est conservée sous 
Outils > Options > LibreOffice > Sécurité > Autorités d’horodatage (TSA). Si aucune 
URL d’une autorité d’horodatage n’est sélectionnée (cas par défaut), la date et l’heure de la 
signature ne seront pas certifiées mais seront celles de votre ordinateur local.
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Exporter vers d’autres formats

LibreOffice utilise le terme « exporter » pour des opérations qui impliquent un changement de type 
de document. Si vous voulez utiliser un autre format de classeur (par exemple, Microsoft Excel), 
utilisez Fichier > Enregistrer sous. Si vous voulez créer une page web à partir de votre classeur, 
utilisez Fichier > Exporter

Envoyer des classeurs par courriel

LibreOffice propose plusieurs moyens pour envoyer rapidement et facilement des documents 
comme pièces jointes à des courriels dans le format OpenDocument (format par défaut de 
LibreOffice), dans d’autres formats de classeur ou sous forme de fichier PDF.

Pour envoyer le classeur comme courriel :

 1) Sélectionnez Fichier > Envoyer dans la barre de menu et choisissez une des options sui-
vantes dans le sous-menu. LibreOffice ouvre votre programme de courrier électronique par 
défaut (s’il est défini). Le document est attaché en pièce jointe.

– Document par e-mail : le classeur est envoyé dans le format ODF courant.

– Envoyer par e-mail en classeur OpenDocument : le classeur est envoyé en format 
ODF.

– Envoyer par e-mail en Microsoft Excel : le classeur est envoyé en format Excel (.xlsx).

– Envoyer par e-mail en PDF : la boîte de dialogue Options PDF s’ouvre pour vous per-
mettre de choisir les paramètres à utiliser pour le fichier PDF. Voir « Contrôler le contenu
et la qualité du fichier PDF », page 18.

 2) Dans votre programme de courrier électronique, indiquez le destinataire, le sujet et ajoutez le
texte que vous désirez puis envoyez le courriel.

Signature numérique des documents

Pour signer numériquement un document, vous avez besoin d’une clé personnelle appelée aussi 
certificat. Celle-ci est stockée sur votre ordinateur sous forme d’une combinaison d’une clé privée, 
qui doit être gardée secrète, et d’une clé publique, que vous ajoutez à votre document quand vous 
le signez. Vous pouvez obtenir un certificat d’une autorité de certification qui peut être une société 
privée ou une institution gouvernementale.

Quand vous appliquez une signature numérique à un document, une sorte de somme de contrôle 
est calculée à partir du contenu du document et de votre clé personnelle. Cette somme de contrôle
et votre clé publique sont stockées ensemble dans le document.

Quand quelqu’un ouvre par la suite le document sur n’importe quel ordinateur avec une version ré-
cente de LibreOffice, le programme recalcule la somme de contrôle et la compare à celle qui est 
stockée. Si les deux sont identiques, le programme vous signale que vous voyez le document ori-
ginal non modifié. En supplément, il peut vous montrer les informations de la clé publique à partir 
du certificat. Vous pouvez comparer la clé publique avec celle qui est publiée sur le site web de 
l’autorité de certification. Dès que quelqu’un modifie quelque chose dans le document, le change-
ment casse la signature numérique.
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Sous les systèmes d’exploitation Windows, les fonctions de validation de signature de Windows 
sont utilisées. Sous Linux, les fichiers qui sont fournis par Thunderbird, Mozilla ou Firefox sont utili-
sés. Pour une description plus détaillée de la façon d’obtenir et de gérer un certificat et une valida-
tion de signature, voyez « À propos des signatures numériques » dans l’Aide de LibreOffice.

Appliquer une signature numérique

La procédure ci-dessous n’est qu’un exemple de la façon dont on signe un document numérique-
ment. La procédure à appliquer effectivement dépend des paramètres de votre ordinateur et de 
son système d’exploitation.

 1) Ouvrez le fichier que vous souhaitez signer numériquement.

 2) Choisissez Fichier > Signatures numériques > Signatures numériques dans la barre de 
menu.

– Si vous avez configuré LibreOffice pour vous avertir quand le document contient des com-
mentaires (voir « Supprimer les données personnelles » page 28), une boîte de mes-
sage peut apparaître pour vous demander si vous voulez continuer la signature du docu-
ment. Cliquez sur Oui pour continuer ou sur Non par arrêter et supprimer les commen-
taires avant de relancer la procédure.

– Si vous n’avez pas enregistré le document depuis la dernière modification, un message 
apparaît. Cliquez sur Oui pour enregistrer le fichier.

 3) La boîte de dialogue Signatures numériques s’ouvre (Figure 23). Cliquez sur Signer le do-
cument pour ajouter une clé publique au document.

Figure 23 : Signatures du document.

 4) Dans la boîte de dialogue Sélectionner le certificat (Figure 24), choisissez votre certificat et 
cliquez sur OK pour revenir à la boîte de dialogue Signatures numériques.

Le certificat utilisé s’affiche dans la boîte de dialogue précédé d’une icône qui indique l’état 
de la signature numérique :

– Une icône avec un sceau rouge ( ) indique que le document a été signé et le certificat 
validé.
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– Une icône avec un panneau d’avertissement jaune sur un sceau rouge ( ) indique que 
le document est signé mais que le certificat n’a pas pu être validé.

– Une icône avec un panneau d’avertissement jaune ( ) indique une signature numérique 
incorrecte.

Figure 24 : la boîte de dialogue Sélectionner le certificat.

 5) Cliquez sur Fermer pour appliquer la signature numérique.

Un document signé affiche une icône dans la barre d’état. Un double clic sur cette icône vous per-
met de voir le certificat. Plusieurs signatures peuvent être ajoutées à un document.

Remarque

Si vous apportez des modifications au document après sa signature numérique, celle-ci est 
automatiquement supprimée et vous devez recommencer la procédure ci-dessus pour le si-
gner de nouveau.

Signer plusieurs fois avec la même signature

Auparavant, LibreOffice interdisait la création de signatures multiples d’un document par le même 
auteur, car signer plusieurs fois le même document n’avait aucune signification sémantique. 
LibreOffice offre désormais une description de signature, si bien que des signatures multiples du 
même auteur sont autorisées, car chacune peut avoir une signification différente.

Quand vous sélectionnez Fichier > Signatures numériques > Signatures numériques, la boîte 
de dialogue Signatures numériques (Figure 23) affiche les signatures existantes ainsi que leurs 
descriptions (le cas échéant).

Quand vous cliquez sur Signer le document, la boîte de dialogue Sélectionner le certificat (Figure
24) vous demande maintenant une description qui reste facultative.

Modifier la valeur d’une description existante invalide la signature.

Signer numériquement les macros

Normalement, les macros font partie d’un document. Si vous signer celui-ci, les macros qu’il 
contient sont automatiquement signées. Si vous souhaitez ne signer que les macros, mais pas le 
document, sélectionnez Outils > Macros > Signature numérique dans la barre de menu et appo-
ser une signature comme décrit ci-dessus.
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Supprimer les données personnelles

Vous aurez peut-être envie d’être certain que les données personnelles, les versions, les notes, les
informations cachées ou les modifications enregistrées ont été supprimées des fichiers avant de 
les envoyer à d’autres personnes ou de vous en servir pour créer des PDF.

• Dans la section Options et avertissements de sécurité de la page LibreOffice – Sécurité 
de la boîte de dialogue Options (Outils > Options), vous pouvez configurer LibreOffice pour 
qu’il vous avertisse quand les fichiers contiennent certaines informations et pour qu’il sup-
prime automatiquement les informations personnelles à l’enregistrement.

• Pour supprimer les données personnelles, et quelques autres, d’un fichier, sélectionnez Fi-
chier > Propriétés Dans l’onglet Général, décochez Utiliser les données d’identité puis cli-
quez sur Réinitialiser les propriétés. Cela supprime les noms dans les champs Créé et 
Modifié, efface les dates de modification et d’impression et remet la durée totale d’édition à 
zéro, la date et l’heure de création à leurs valeurs courantes et le numéro de révision à 1.

• Pour supprimer les informations de version, vous pouvez soit sélectionner Fichier > Ver-
sions dans la barre de menu, choisir une version dans la liste puis cliquer sur Supprimer, 
soit sélectionner Fichier > Enregistrer sous et sauvegarder le fichier sous un autre nom.
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